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Visual Build Overview

Are you a developer?    Do you use Windows as your development platform?    Then Visual Build is the 
way to simplify your routine development tasks and increase your productivity.    Visual Build is a utility 
that automates such tasks as building your software application, retrieving the latest source code, 
registering components, and much more.    It will execute all those tedious steps that must be performed 
over and over again, while ensuring that all steps have been successfully completed.    If any step fails, 
Visual Build continues from the point of failure after the problem has been corrected.

Visual Build features include:

· Supports Windows 95, Windows 98, and Windows NT: Integrates with the Windows shell.    
Supports drag and drop for opening projects and for moving data around in and between Visual Build 
instances.

· Microsoft Visual Studio Support: Visual Build keyboard shortcuts are similar to Visual Studio and it 
comes pre-configured with support macros for Visual Studio tools (Visual Basic, SourceSafe, 
NMAKE, etc.).

· Extremely Flexible: Can invoke any application, batch file, or operating system command that 
returns an exit code (supports calling of applications that don’t return an exit code, but cannot 
determine their success or failure).

· Powerful & Extensible: Easily handles complex development scenarios. Macro replacement feature 
allows generic programming of project steps.

· Easy to Use: Uses an intuitive Windows interface to define and build your project. Tooltips are used 
extensively to simplify debugging and increase productivity.

· Automated Invocation: Can be started from the command-line, from a batch file, or from another 
instance of Visual Build, allowing projects to be chained together.    When used in conjunction with the 
AT service or the System Agent, it can be used to perform scheduled builds.



Getting Started

Visual Build starts with a new, empty project.    Visual Build is an SDI app (only one file can be open at a 
time), but multiple instances of Visual Build can be started.    Visual Build projects are stored in files with a 
.bld extension.

The main Visual Build window shows the steps in your project in the top half of the splitter and the output 
from a build in the bottom half.    To get started, insert the steps and macros that make up your project.    
The checkbox in front of each step determines if the step will be included in a build; click the checkbox to 
toggle its state (all steps below it that are indented from it are also toggled).    For Command, Start In, and 
Output File columns containing macros, holding the mouse over that field will show the value with all 
macros expanded.    The description of a step will be shown in a tooltip when the mouse is held over the 
Step Name column.

There are three ways to build a project:

· Build executes all steps with a checkmark that have not been completed. 

· Rebuild performs all steps with a checkmark regardless of their completion status.

· Rebuild Selected performs all selected steps.



During the build, all operations are disabled except Stop Build.    The step window shows which step is 
being processed, and the output of the steps is shown in the output window.    If any step fails, the build 
stops and the failed step is highlighted.    This allows you to fix whatever caused the step to fail and 
continue from the failure.    The step build status is not saved with the project file; it is reset each time you 
open a project.



Step Properties Dialog

The Step Properties dialog is used to add new steps to a project or modify existing steps.    It is accessed 
from the Properties button on the toolbar or the Properties item on the View menu.

Name: Required.

Command: Specifies the process to invoke.    It can contain the executable name plus any parameters 
that should be passed to it (optional; empty steps are ignored).

Start In: The path that will be the starting directory for the process (optional).    Some applications, such 
as NMAKE, require this parameter to work correctly.

Browse: This button can be used for the Command, Start In, and Output File fields.    It displays a dialog 
to browse for the selected file or folder.

Macros: The Macros button can also be used with the Command, Start In, and Output File fields to add 
macros to the field.    A list of all defined macros is displayed and double-clicking the macro inserts it into 
the field at the current caret position.    Macro names can also be entered manually.    A macro is indicated 
by placing a percent sign (%) on each side of the macro name (i.e., %DOSCMD%).    If the macro takes 
parameters, enter them in parentheses after the macro, separating the values with commas [i.e., 
%ATTRIB(-r, *.bat)%].    A literal percent sign can be entered in a field by entering two percent signs (%%). 
When the mouse cursor is held over one of these fields, all macro values expanded and shown in a 
tooltip.    This is the actual string that will be used when building the step.    Note: calling macros with 
parameters in another macro’s parameter is not supported.

Description: A comment describing the step (optional).

Read Output From: Selects where to read the step’s output from.    Most processes write their output to 
standard output.    Some (such as the Microsoft Visual Basic compiler) write their output to a file.    If ‘A 
File’ is selected, an Output File to read from must be entered, and Visual Build can delete this file before 
building the step if desired.

Window: By default, the process window is hidden when building, but you can choose to show it with this 
field.    This may be necessary for applications that might display a dialog box or to view applications that 
cannot write their output to standard output or a file.

Ignore Failure: Visual Build determines the success of the process by examining the exit code of the 
process.    A zero (0) exit code is considered successful, and any other code is a failure.    Normally a build 
stops if any step fails.    This behavior can be overridden by checking the Ignore Failure field, causing the 
build to continue even if the step returns a non-zero exit code.

Note: Under Windows 95 & 98, the operating system is unable to retrieve the exit code for OS commands 
(i.e., DIR, COPY, etc.) or batch files, so Visual Build will think the step succeeded even if it didn't.    Also, 
some applications do not return an exit code; Visual Build can still invoke them but cannot determine 
success or failure of the step.



Macros Dialog

The Macros dialog is used to manage Visual Build macros.    It is accessed from the Macros button on the 
toolbar or the Macros item on the Project menu.

There are four (4) types of macros, with one tab for each type.    Project macros are stored in the project 
file.    Global macros are stored in the registry and exist for all projects.    System macros are the Windows 
environment variables plus some predefined Visual Build macros; they are read-only.    Override macros 
are global macros that exist only for a single Visual Build session.    They are assigned by passing them 
on the command line to Visual Build or by adding them to the Override tab.    If the same macro exists for 
more than one type of macro, the order of precedence (from highest to lowest) is:

· Override

· Project

· Global

· System (Environment variables take precedence over predefined Visual Build macros)

Macros can be copied and pasted from one tab to another and from one Visual Build instance to another.



Macro Properties Dialog

The Macro Properties dialog is used to add new macros or modify existing macros.    Macros replace a 
particular string in the project with another string.    Using macros, you can: 

· Create a project that can build different projects.

· Specify options for commands.

· Make your project generic.

Name: Required.

Parameters: (Optional) Specifies parameters that can be passed to the macro.    Parameters are 
separated by commas. 

Value: The value to replace a reference to this macro with.    If the macro has parameters, each 
parameter must be used at least once in the macro value.    Macros can contain other macros to any level 
of nesting (although a macro cannot reference itself).    To reference a macro, place a percent sign (%) 
sign around the macro name (i.e., %DEVSTUDIODIR%).    If other macros are referenced, a tooltip shows 
the expanded macro value when the mouse cursor is held over it.

Description: A comment describing the purpose of the macro (optional).

You can define your own macros, use existing environment variables, or use predefined Visual Build 
macros.

Macros can be used in a step’s Command, Start-In, and Output File fields.



Insert Macro Dialog

Displays a list of all defined macros to simplify inserting into the current field.    If a macro takes 
parameters, those parameters are shown in parentheses after the name.    When the mouse cursor is 
held over a macro, its value is shown in a tooltip.    Clikc OK to insert the selected macro; Visual Build 
automatically adds the necessary percent sign (%) characters around the macro when inserting.



Predefined Macros

Visual Build comes built in with the following predefined system macros.    Windows NT also defines 
some of these macros as environment variables, which will take precedence over Visual Build’s definition, 
and you can override these values by defining your own project or global macros:

· DOSCMD: Executes an operating system command (i.e., DIR, COPY, ECHO, etc.).    Under Windows 
NT, this executes CMD.EXE; under Windows 95 and 98, it executes COMMAND.COM.

· WINDIR:  The Windows directory.

· WINSYSDIR: The Windows System directory.

· COMPUTERNAME: The current computer name.

· USERNAME: The logged on user’s username.

· VISBUILD: The path to the current instance of Visual Build.

· VISBUILDDIR: The path and filename of the current instance of Visual Build.

· PROJDIR: The path to the open Visual Build project file.

· PROJFILE: The path and filename of the open project file.

· DATE: Inserts the current date and time.

Visual Build also creates the following global macros when running for the first time.    Some of these will 
need to be modified to point to the actual location on your computer, and they can be deleted if not 
needed as well:

· DEVSTUDIODIR: The base directory for Microsoft Visual Studio.

· SRCSAFE: The command to invoke Microsoft Visual SourceSafe from the command-line.

· SSFLAGS: Default command-line flags when running SourceSafe.

· SSDB: Set the location of the SourceSafe server for command-line invocation.

· VB: The command to start Microsoft Visual Basic from the command-line to build a project.    Note: 
Visual Basic writes its output to a file instead of standard output.

· ATTRIB: Changes file attributes.

· ECHOW: Write text to a file (overwriting the file if it exists).

· ECHOA: Write text to a file (appending to the file if it exists).

· REGSVR: Register a COM/ActiveX server (dll, exe or ocx).

· REGEDIT: Import a registry file into the registry.

Note: All the Microsoft Visual Studio command-line tools, such as NMAKE, MIDL, and RC, can also be 
invoked from Visual Build even though macros are not defined for them.    These macros above are pre-
configured for use with Visual Studio 6.0, but they will work with Visual Studio 5.0 as well (the paths may 
need to be changed).



Options Dialog

The Options dialog is used to modify global Visual Build settings.    It is accessed from the Options item on 
the View menu:

· General: Determines whether a project file is automatically saved before building, and whether the 
previously opened project is opened the next time Visual Build is started.

· Display: Sets properties on the Step window, and turns tooltips on or off.

· Columns: Determines which columns are displayed in the step window.    The mouse can also be 
used to resize, show and hide columns.

· Logging: Turns logging on and off.    Visual Build always logs build output to the output window, but 
file logging can also be enabled to provide a permanent log of build activity.



Tooltip Features

Visual Build uses tooltips extensively to aid in creating and debugging steps and macros.    Tooltips are 
displayed when the mouse cursor is held over a field for a couple seconds.

· Step Window: The step description (if there is one) is shown when the mouse is over the Step Name 
column.    If the Command, Start In, or Output File column contains macros, the value with all macros 
expanded is shown.

· Macros Dialog: If the macro has parameters, its parameters are shown in a tooltip when the mouse 
is held over the Name column.    If the macro column references other macros, the expanded value is 
shown in a tooltip.

· Macro Properties Dialog: If the macro references other macros, the expanded values are displayed 
in a tooltip over the Value field.

· Insert Macro Dialog: The macro value (without nested macros expanded) and its description are 
displayed in a tooltip when the mouse is held over a macro in the list.



Drag & Drop Support

Visual Build supports drag and drop in the following ways:

· Select one or more steps in a project and drag and drop them to move or copy within a project.    By 
default, the steps are moved; to copy the selected steps, hold down the Ctrl key before dropping.    
The steps are inserted after the step they are dropped onto.

· Select one or more steps in a project and drag and drop them to another instance of Visual Build or 
another application.    By default, the steps are copied; to move the selected steps, hold down the 
Shift key before dropping.    When dropping on other applications, the step indentation and 
descriptions only are pasted.

· Create step descriptions in a text editor such as NotePad, select the text, and drag and drop it onto 
Visual Build.    A step is created for each line in the selection, with a indent for each tab.

· Cut, copy, and paste of steps within a project and between instances of Visual Build is also supported 
via the Edit menu commands.    The steps are inserted after the currently selected step.



Explorer Interface

Visual Build integrates with the Windows Explorer:

· Drag a Visual Build project file from the Windows Explorer and drop it on a Visual Build window to 
open the project.

· Double-click a file with a .bld extension from Windows Explorer to open it in Visual Build.

· To create a new Visual Build project from Explorer, click File|New|Visual Build Project from the menu, 
or right-click and choose New|Visual Build Project.



Hints & Tips

· Wrap step command filenames and parameters in double quotes (“) if they contain spaces so that 
they are evaluated as a single value.

· Any internal or external OS command can be called using the DOSCMD system macro.    This 
includes COPY, XCOPY, MKDIR, RMDIR, MOVE, ATTRIB, FIND, DEL, DIR, ECHO, FORMAT, SYS, 
etc.

· Using the DOSCMD macro will allow most commands to operate under both Windows 95/98 and NT 
without change, unless OS-specific commands are used.

· A project step can invoke another instance of Visual Build for complex chaining capabilities (use the 
VISBUILD system macro).    For example, you could create a master project and a generic child 
project, and call the child project multiple times, passing different override macros each time (see 
command-line options).

· Group your project steps by different indentation levels to improve organization.    Clicking the 
checkbox for a step quickly checks or unchecks all subordinate steps as well.    Clicking the folder 
icon of the top level ‘Project steps’ item checks or unchecks all steps in the project.



Command-line Invocation

Visual Build can be started from the command-line.    It supports the following syntax:

VisBuild[.exe] [/a] [/s] [MACRO=VALUE …] [/b] [ProjectFile.bld]

/a – specifies that all steps should be built (normally only the checked steps are processed).

/s – indicates silent mode (does not prompt for input if an error occurs).

MACRO=VALUE – defines or overrides one or more macro values.

/b – tells Visual Build to open and build the specified project.    If the build succeeds, Visual Build exits with 
a 0 code; if the build fails, a non-zero exit code is returned to the operating system.

ProjectFile.bld – indicates the Visual Build project to open



Visual Build Menus

File Menu

New Creates a new Visual Build project.

Open Opens an existing project.    Visual Build project files have a .bld 
extension.

Save Saves the current project.

Save As Saves the current project to a specified filename.

Recent File Opens a recently opened project.

Exit Exits Visual Build.

Edit Menu

Insert Adds a step to the project.    The step is inserted after the selected step.

Delete Deletes the selected steps from the project.

Cut Cuts the selection and moves it to the clipboard.

Copy Copies the selection to the clipboard.

Paste Pastes data from the clipboard into the project.

Select All Selects all steps in the project.

Word Wrap Toggles word wrap of the output window.

Find Finds the specified text in the output window.

View Menu

Step Activates the step window to allow editing of steps and viewing of 
expanded macro values.

Output Activates the output window to view output of steps that have been 
built.

Split Adjusts the splitter window position

Options Configures global application options.

Properties Allows editing of a step’s properties.

Project Menu

Build Builds all uncompleted, checked steps of the project.

Rebuild Rebuilds all checked steps of the project regardless of completion 
status.

Rebuild Selected Rebuilds all selected steps regardless of completion status.

Stop Stops the current build.

Include in Build Toggles inclusion of the selected step and all subordinates steps in a 
build.

Move Up Moves the selected steps up in the project.

Move Down Moves the selected steps down in the project.

Indent Indents the selected steps.



Unindent Unindents the selected steps.

Macros Activates the Macros dialog for adding and editing macros.

Help Menu

Contents Offers an index of topics on which to get help.

License Shows the Visual Build license agreement.

Ordering Displays Visual Build ordering information.

Keyboard Map Shows the key mappings available for Visual Build commands.

About Displays the version number of this application.



Keyboard Map

F1 Activates the help system

Shift+F10 Activates a popup menu for the current window

Ctrl+N Creates a new Visual Build project

Ctrl+O Opens an existing project

Ctrl+S Saves the current project

Alt+F4 Exits Visual Build

Ins Inserts a step into the project

Del Deletes the selected steps from the project

F2 Edits the selected step description in the step window

Enter Displays the Step Properties dialog for the selected step

Spacebar Toggles inclusion of the selected steps in the build

Tab Indent the selected steps

Shift+Tab Unindent the selected steps

Ctrl+X Cut

Ctrl+C Copy

Ctrl+V Paste

Ctrl+F Find

Ctrl+M Displays the Macros dialog

F6 Toggles between the step and output window

F7 Builds the uncompleted, checked steps

Shift+F7 Rebuilds all checked steps

Ctrl+F7 Rebuilds all selected steps

Ctrl+Break Stops the build

Copyright, License, & Warranty

Visual Build™ Copyright © 1999 Kinook Software
All Rights Reserved.

This license applies to the registered version of Visual Build.    If you are using an evaluation version of 
Visual Build, see the Evaluation License.

License Agreement

This End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a 
single entity) and Kinook Software for the software product identified above, which includes computer 
software and may include associated media, printed materials, and "online" or electronic documentation 
("SOFTWARE PRODUCT").    By installing, copying, or otherwise using the SOFTWARE PRODUCT, you 
agree to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, do not install 
or use the SOFTWARE PRODUCT.



SOFTWARE PRODUCT LICENSE
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as 
other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE. This EULA grants you the following rights:
Software.    You may install and use one copy of the SOFTWARE PRODUCT on the COMPUTER.

Storage/Network Use.    You may also store or install a copy of the computer software portion of the 
SOFTWARE PRODUCT on the COMPUTER to allow your other computers to use the SOFTWARE 
PRODUCT over an internal network, and distribute the SOFTWARE PRODUCT to your other computers 
over an internal network.    However, you must acquire a license for the SOFTWARE PRODUCT for each 
computer on which the SOFTWARE PRODUCT is used or to which it is distributed.    A license for the 
SOFTWARE PRODUCT may not be shared or used concurrently on different computers.

Backup Copy.    You may make a single backup copy of the SOFTWARE PRODUCT.    You may use the 
backup copy solely for archival purposes.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.
Limitations on Reverse Engineering, Decompilation, and Disassembly.    You may not reverse 
engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such 
activity is expressly permitted by applicable law notwithstanding this limitation.

Separation of Components.    The SOFTWARE PRODUCT is licensed as a single product. Its 
component parts may not be separated for use on more than one computer.

Single Computer.    The SOFTWARE PRODUCT is licensed with the COMPUTER as a single integrated 
product.    The SOFTWARE PRODUCT may only be used with the COMPUTER.

Rental.    You may not rent or lease the SOFTWARE PRODUCT.

Software Transfer.    You may not transfer your rights under this EULA.

Termination.    Without prejudice to any other rights, Kinook Software may terminate this EULA if you fail 
to comply with the terms and conditions of this EULA.    In such event, you must destroy all copies of the 
SOFTWARE PRODUCT and all of its component parts.

3. COPYRIGHT.
All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images, 
photographs, animations, video, audio, music, text, and "applets" incorporated into the SOFTWARE 
PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE PRODUCT are 
owned by Kinook Software.    The SOFTWARE PRODUCT is protected by copyright laws and 
international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any other 
copyrighted material except that you may install the SOFTWARE PRODUCT on a single computer 
provided you keep the original solely for backup or archival purposes.

Disclaimer of Warranty 

NO WARRANTIES.
Kinook Software expressly disclaims any warranty for the SOFTWARE PRODUCT. The SOFTWARE 
PRODUCT and any related documentation is provided "as is" without warranty of any kind, either express 
or implied, including, without limitation, the implied warranties or merchantability, fitness for a particular 
purpose, or noninfringement. The entire risk arising out of use or performance of the SOFTWARE 
PRODUCT remains with you.

NO LIABILITY FOR DAMAGES.



In no event shall Kinook Software be liable for any damages whatsoever (including, without limitation, 
damages for loss of business profits, business interruption, loss of business information, or any other 
pecuniary loss) arising out of the use of or inability to use this product, even if Kinook Software has been 
advised of the possibility of such damages. 



Evaluation License & Warranty

Visual Build™ Copyright © 1999 Kinook Software
All Rights Reserved.

This license applies to the unregistered evaluation version of Visual Build.    If you have purchased a 
license for the registered version of Visual Build, see the License, Copyright, & Warranty section.

License Agreement

This End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a 
single entity) and Kinook Software for the software product identified above, which includes computer 
software and may include associated media, printed materials, and "online" or electronic documentation 
("SOFTWARE PRODUCT").    By installing, copying, or otherwise using the SOFTWARE PRODUCT, you 
agree to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, do not install 
or use the SOFTWARE PRODUCT.

SOFTWARE PRODUCT LICENSE
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as 
other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE. This EULA grants you the following rights:
Installation and Use. You may install and use an unlimited number of copies of the SOFTWARE 
PRODUCT.

Reproduction and Distribution. You may reproduce and distribute an unlimited number of copies of the 
SOFTWARE PRODUCT; provided that each copy shall be a true and complete copy, including all 
copyright and trademark notices, and shall be accompanied by a copy of this EULA. Copies of the 
SOFTWARE PRODUCT may be distributed as a standalone product or included with your own product.

This is not free software.    You are hereby licensed to use this software for evaluation purposes without 
charge for a period of 21 days.    If you use this software after the 21-day evaluation period, a license for 
the non-evaluation version must be purchased.    When payment is received you will be sent a registered 
copy of the latest version of Visual Build.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

Limitations on Reverse Engineering, Decompilation, and Disassembly.    You may not reverse 
engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such 
activity is expressly permitted by applicable law notwithstanding this limitation.

Separation of Components.    The SOFTWARE PRODUCT is licensed as a single product. Its 
component parts may not be separated for use on more than one computer.

Software Transfer.    You may permanently transfer all of your rights under this EULA, provided the 
recipient agrees to the terms of this EULA.

Termination.    Without prejudice to any other rights, Kinook Software may terminate this EULA if you fail 
to comply with the terms and conditions of this EULA. In such event, you must destroy all copies of the 
SOFTWARE PRODUCT and all of its component parts.

Distribution.    The SOFTWARE PRODUCT may not be sold or be included in a product or package 
which intends to receive benefits through the inclusion of the SOFTWARE PRODUCT. The SOFTWARE 
PRODUCT may be included in any free or non-profit packages or products.



3. COPYRIGHT.

All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images, 
photographs, animations, video, audio, music, text, and "applets" incorporated into the SOFTWARE 
PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE PRODUCT are 
owned by Kinook Software.    The SOFTWARE PRODUCT is protected by copyright laws and 
international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any other 
copyrighted material except that you may install the SOFTWARE PRODUCT on a single computer 
provided you keep the original solely for backup or archival purposes.

DISCLAIMER OF WARRANTY 

NO WARRANTIES.
Kinook Software expressly disclaims any warranty for the SOFTWARE PRODUCT. The SOFTWARE 
PRODUCT and any related documentation is provided "as is" without warranty of any kind, either express 
or implied, including, without limitation, the implied warranties or merchantability, fitness for a particular 
purpose, or noninfringement. The entire risk arising out of use or performance of the SOFTWARE 
PRODUCT remains with you.

NO LIABILITY FOR DAMAGES.
In no event shall Kinook Software be liable for any damages whatsoever (including, without limitation, 
damages for loss of business profits, business interruption, loss of business information, or any other 
pecuniary loss) arising out of the use of or inability to use this product, even if Kinook Software has been 
advised of the possibility of such damages.



Visual Build Support

To check whether you have the most recent version of Visual Build, please check the Kinook Software 
home page at http://www.kinook.com.

Technical support is available at no charge as described below.    The best way to report problems is by 
sending e-mail to support@kinook.com on the Internet, or send postal mail to Kinook Software, P.O. Box 
25455, Colorado Springs, CO 80936.

When reporting problems, please include the following information:

1. Is the problem reproducible?    If so, how?

2. What version of Windows are you running?    For example, Windows 95, Windows NT 4.0 Service 
Pack 3, etc.

3. What version of Visual Build are you running?    Select About Visual Build from the Visual Build Help 
menu.    Include the entire version line in your problem report.

4. If a dialog box with an error message was displayed, please include the full text of the dialog box, 
including the text in the title bar.

Note: You can press F1 at any time while Visual Build is active for context sensitive help.



System Requirements
Visual Build requires Windows 95, Windows 98, or Windows NT 4.0 or later.

Visual Build also requires version 4.70 or later of the Windows Common Control library. This library is part 
of Windows 98, Microsoft Internet Explorer 3.0 and later, and is also available as a separate download 
from the Microsoft web site at ftp://ftp.microsoft.com/Softlib/MSLFILES/40comupd.exe.



Visual Build Ordering Information

Immediate online delivery of registered copies of Visual Build is available for credit card orders placed via 
the Internet from the Visual Build home page at http://www.kinook.com.    If you prefer, Visual Build can 
also be ordered by telephone.    Please see the web page for details.

All orders are subject to the Visual Build License Agreement.    The registered version does not display the 
about dialog on startup and does not limit the number of steps in a project.

Pricing

Single Copy: $29 each

Visual Build Site Licenses

2 to 9 computers: $27 each

10 to 24 computers: $25 each

25 to 49 computers: $22 each

50 to 99 computers: $19 each

100 to 199 computers: $15 each

200 to 499 computers: $11 each

500 or more computers: $6 each

Prices guaranteed through March 2000.

Customer information is considered confidential and will not be shared or distributed to any third party.




